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KIRISH

Xozirgi davr — axborot texnologiyalari rivoj topgan davr, shu sababli biz
ta’lim tizimini o’zgartirib, ta’lim tizimiga yangiliklar kiritishimiz lozim. Ushbu
yangiliklar nimalardan iborat bo’lishligi lozim? Ular birinchi navbatda kimlarga
moljallangan bo’lishi kerak? Ushbu savollarni biz magistrlik dissertatsiya borisida
ko’rib chiqishga harakat qilamiz. Ushbu magistrlik dissertatsiya kirishuv
bo’limidan, 3 bobtan, xulosalardan va foydalanilgan adabiyotlar ro’yxatidan iborat.

Mavzu dolzarbligi. Bizning fikrimizcha, dissertatsiya mavzusi Xozirgi
zamonga mos, actual bo’lib topiladi, sababi xozirgi zamonimizning ta’lim tizimiga
qo’yadigan talablari shunday-ki, ularga javob berish uchun ta’lim tizimiga yangi
pedagogic texnologiyalar kiritilish lozim va ushbu texnologiyalar, albatta, axborot
texnologiyalariga asoslangan bo’lishi kerak.

Birinchi bobda Delphi dasturlash muhiti va undagi ma’lumotlar bazalari
bilan ish yurutuvchi texnologiyalar hagida tushunchalar berilgan.

Ikkinchi bobda Delphi muhitida pedagogic o’rgatuvchi dasturiy vositalar va
o’quvchilar bilimini tekshiruvchi dasturiy vositalar yaratilishi ko’rib chiqilgan.

Uchinchi bobda esa ushbu vyaratilgan dasturiy vositalar kompleksini
ma’lumotlar bazasi bilan bog’lash yoki integratsiyalash usullari ko’rib chiqilgan.
Barcha dasturiy vositalar maktab kursidagi matematika masalalarini yechish uchun

muljollangan.



I-BOB. DELPHI DASTURLASH MUHITI

1.1. DELPHI DASTURLASH MUHITI HAQIDA TUSHUNCHALAR

Delphi tizimi - bu Windows uchun yaratilgan dastur mubhiti va dasturlash tili
bo’lib 1995 yilda Borland kompaniyasi guruhi dastur tuzuvchilari Chak (Chuck) va
Denni (Danny) tomonidan yaratilgan.

Bu til o’zining keng qamrovli imkoniyatlariga egaligi bilan birga, boshqa
dasturlash tillaridan o’zining ba’zi bir xususiyatlari bilan ajralib turadi. Delphi
dasturlash tilida dasturlar visual loyihalashning hozirgi zamon texnologiyalari
asosida yaratiladi, 0’z navbatida ob’eykga mo’ljallangan dasturlash g’oyasiga
asoslangan. Borland Delphining paydo bo’lishi dasturlashni rivojlantirish tarixida
yorgin ko’rinish bo’ldi. Delphi dasturlash tilidagi dasturlar Object Pascal tilida
yoziladi, bu til Turbo Pascal tilining davomi va takomillashtirilganidir. Uning
soddaligi, yuqori sifatli komplyatorga ega ekanligi va dasturlar yaratishning qulay
muhitiga ega bo’lishi sabab bo’lgan. Delphining dunyoga kelishiga quyidagi
tendensiyalar sabab bo’ldi:

* \Windows uchun dasturlash va komponentlar texnologiyasi;

* Masalalarni yechish uchun obyektga yo’naltirilgan usul;

* Komponentlar texnologiyasiga asoslangan ilovalarni tez yaratishning vizual
muhitlari;

* |nterpretatsiyadan emas, kompilatsiyadan foydalanish. Bu shundan iboratki,
interpretator bilan ishlashga qaraganda kompilator bilan ishlash tezligi o’n
martalab ustunlikka ega bo’ladi;

* Universal usullar yordamida ma’lumotlar bazasi bilan ishlash imkoniyatlarining
mavjudligi;

Masalan, lokal va shu bilan bir qatorda server ma’lumotlari faylidan mijoz-

server arxitekturasiga yoki ko pbosqichli N-tier sxemasiga o’tishni ta’minlash.



Dasturiy texnologiyalar bir joyda turib gqolmagani kabi Borland (1998 vil
apreldan Inprise Corporation) firmasining navbatdagi kuchli mehnatlari natijasida
Turbo Pascal tili o’rniga Object Pascal tili — ob’eykga mo’ljallangan dasturlash
konsepsiyasini 0’zida mujassamlashtirgan tili yuzaga keldi.

Delphi va Object Pascal uzoq evalyusion rivojlanish natijasi va hozirgi
zamon kompyuter texnologiyalarining o’zida akslantiruvchi mahsulotdir. Xususan,
Delphi yordamida har xil dasturlar — konsol ilovalardan tortib, ma’lumotlar bazasi
bilan, internet bilan ishlash dasturlarigacha tuzuish mumkin. Shunday ekan Delphi
dasturini o’rganishni nimadan boshlash kerak degan savol tug’iladi? Delphi
dasturlash tili bilan tanishishni Object Pascal tilini o’rganish va bu tilni konsol

ilovalarni yaratish uchun dasturkash tuzishda qo’llashdan boshlasa bo’ladi.
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Borland Delphi yugorida bayon etilgan tendensiyalarni joriy etish magsadida

yaratilgan. Ammo, uning eng asosiy elementi Obyekt Paskal tili bo’lib hisoblanadi.

Delphi ning ba’zi bir 0’ziga xos xususiyatlariga to’xtab o’tamiz. Delphining
ixtisoslashtirilgan dasturlash muhiti quyidagilarni 0’z ichiga oladi:

AppBrowser tahrirlagichi (redaktori)

Formalar Konstruktori loyiha (proyekt) boshqgaruvchisi (menedjeri)

Delphi faylllari

Obyektlar bazasi (Object Repositary)



Dasturlashtirishning Delphi ga o’xshash vizual asboblarida dasturlash mubhiti
ko’pincha shu muhitda ishlatiladigan dasturlash tilidan muhimroq ahamiyatga ega.
Delphi 4 da vizual dasturlashning butunlay yangi ko’rinishi qo’llanilgan va biz
hozir uni batafsil o’rganib chigamiz.

Delphi 4 tarkibiga kiruvchi tahrirlagich hamma imkoniyatlarini saglab
golgan holda dastur kodini yozishga butunlay yangicha yondoshadi. Bu
yangiliklarning uchta asosiylari: Code Explorer (kod yetakchisi—modulda e’lon
gilingan barcha obyekt va identifikatorlarni ko’rsatadi), kod bo’yicha erkin harakat
ta’minoti (huddi WEB brouzyerdagiday) va kodlarni avtomat generatsiyalash
(hosil gilish)ning yangi texnologiyasi Class Completionlardir.

Code Explorer darchasi modulda ¢’lon qilingan tiplar, o’zgaruvchilar va
modulda ishlatilayotgan boshqa modullarnig ro’yxatini ko’rsatadi. Code Explorer
Klassga o’xshash murakkab turlarning xossalari (cBoiicte), (metodlar)i hagida
batafsil ma’lumot berishi mumkin. Code Exploryerdagi ma’lumotlar kod yozish
davomida avtomat ravishda yangilanib turadi. Bundan tashgari Code Explorer
yordamida siz kerakli obyekt yoki o’zgaruvchilarni topishda foydalanishingiz
mumkin. Buning uchun sichqoncha ko’rsatkichi bilan kerakli obyekt nomini ikki
marta chertish kifoya.

Code Insight. Delphi 4da Code Insight («Kod—ichidany)
texnologiyasining yangilangan shakli qo’llaniladi.Code Insight ning hamma
imkoniyatlari yozilayotgan kodni va unga qo’shilgan VCL metodlarining kodlarini
to’xtovsiz sintaksik analiz qilishshga asoslangan. Bu texnologiyaning asosiy
mezoni boshlovchilar va tajribali dasturchilarning ishini yengillatishdan iborat.
Code Insight quyidagi imkoniyatlarga ega:

Code Completion (kodni  to’ldirish)  Dasturlashtirishni  yangi
o’rganayotganlar uchun juda qo’l keladi. Bunda biror obyektning nomi terilib
nuqta qo’yilgandan keyin metod yoki o’zgaruvchilarning bosh harflari terilishi
bilan o’sha harflar bilan boshlanadigan barcha elementlar ro’yxati chiqariladi. Bu

ruyxatni Ctrl Q probel ni bosib ham chiqarish mumkin.:q belgisi qo’yilgandan esa,



mana shu obyekt yoki o’zgaruvchining tipiga mos barcha obyekt yoki
o’zgaruvchilar ro’yxati chiqariladi.

Code Templates (Kod andozasi) kodlarni kompyuterga kiritishda bir xil
gaytariladigan kodlarni avtomatik ravishda kiritish imkonini beradi. Masalan,
kodlarda if... then begin ... end else begin ... end; konstruksiyasi juda ko’p
uchraydi. Bunday konstruksiyani gayta-gayta terib o’tirmaslik uchun Ctl+Q ni
bosish va chiqarilgan ro’yxatdan kerakli konstruksiyani tanlash kifoya. Bunday
andozalarni istagancha hosil gilish mumkin.

Code Parameters (funksiya parametrlari) funksiya nomi terilib, gavs belgisi
qo’yilgandan keyin ushbu funksiyaning parametrlari ro’yxatini suzib chiquvchi
xabar ko’rinishida chigaradi. Bunda joriy parametr ajratib ko’rsatiladi. Bundan
tashgari Delphi 4 da Code Parametrs o’zgaruvchilarning indalmagandagi,
berilmagan qiymatlarini va gayta yuklanuvchi (overloading) usullarini ham
ishlatishni ta’minlaydi.

Formalar (shakllar) konstruktori

Delphining asosiy darchalaridan birinchisi kod tahrirlagichi bo’lsa,
ikkinchisi shubhasiz, formalar konstruktoridir. Delphining formalar konstruktori
komponentlar palitrasidan foydalanib, formaga istalgan obyektni qo’yishi mumkin
(komponentlar palitrasidan kerakli obyekt tanlanadi, formaga chertiladi, formada
kerakli obyekt standart o’lchamlari bilan paydo bo’ladi.). Bunda yangi hosil
bo’lgan obyektning kodi avtomatik ravishda kod tahrirlagichi yordamida modulga
qo’shib go’yiladi.

Formaga joylashtirilgan komponentlarni Projects sahifasidagi Object
Inspector darchasi yordamida boshgarish imkonini beradi.

Boshlang’ich koddan hodisaga javob beruvchi usulni olib tashlashning eng
yaxshi yo’li bu usha amalning sarlavhasi va kalit so’zlar begin va end dan boshqa
hamma kodni olib tashlashdir.

Proyektlarni boshgarish



Object Inspector ning Events sahifasi yordamida tanlangan komponentlar
bilan hodisalar bog’lanadi. Buning uchun bir gancha usullardan foydalanish
mumkin.

Delphi 4 ning yangiliklaridan biri- bu bir vagning o’zida bir necha proyekt
(loyiha)lar bilan ishlash imkoniyatining mavjudligidir. Bu View > Project
Manager buyrug’i yordamida bajariladi.

Proyektni kompilatsiya qgilish va yig’ish

Proyektni bir necha usul bilan kompilatsiya gilish mumkin. Agar Run > Run
buyrug’i ishga tushirilsa, proyekt bajarilishidan oldin kompilatsiya qilinadi. Bunda
faqat o’zgartirilgan modullargina kompilatsiya qilinadi.

Agar Complite>»> Build All tanlansa, proyektga qo’shilgan modullar
0’zgargan-o’zgarmaganidan qat’iy nazar, kompilatsiya qilinadi.

Proyekt yig’ilishi uchun undagi har bir boshlang’ich fayl Delphining
kompilatsiya gilingan moduli (Document Complited Unit, DCU)ga aylantiriladi.
Bunda fayl Pascal boshlang’ich faylining nomi bilan .dcu kengaytmasi bilan
saglanadi. Proyektning boshlang’ich kodi kompilatsiya qilinganda proyekt
modullarining kodlari VCL kutubxonasi kodlari bilan birgalikda bajariluvchi
faylga kompilatsiya gilinadi.

Complite buyrug’i AppBrowser tahrirlagichiga proyekt yuklangan
paytdagina bajarilishi mumkin. Agar faol proyektlar bo’lmasa, Open Project
komandasi yordamida .PAS kengaytmali faylni ochish va uni sintaksisini tekshirib,
DCU ga kompilatsiya gilish mumkin.

Delphining boshlang’ich fayllari

Formaning Pascal fayli forma turkumi (sinfi) ning tacnifini va gayta
ishlovchilarning boshlang’ich kodlarini saqlaydi. Object Inspector yordamida
o’rnatiladigan xossalar va formaning o’zining ta’rifi alohida .DFM kengaytmali
fayllarda saglaydi.

Bu ikki xil fayldan tashqari proyekt uchun o’ta zarur bo’lgan, Pascal

kodlaridan iborat Delphi ning loyiha fayli (DPR) ham mavjud. Bu fayl loyiha



yaratilayotganda avtomat ravishda hosil gilinadi. Uni View > Project Source

buyrug’i yordamida ko’rish mumkin.

Obyektlar Repozitariysi (bazasi)

Delphida yangi forma, loyiha, ma’lumotlar moduli (Data module) hosil
gilishga imkon beradigan bir necha buyruglar mavjud. Bu buyruglar File>New
tanlanganda chiqgariladi. Bunda Delphi obyektlar repozitariysini ochadi.
Repozitariy ixtiyoriy turdagi yangi elementlar: formalar (shakllar), ma’lumotlar
moduli, ogim obyektlari (thread objects), komponentlar, automation obyektlar va
boshqgalarni yaratish imkonini beradi.

Obyektlar repozitariysiga bundan keyingi loyihalarda ishlatilishi mumkin
bo’lgan yangi elementlarni qo’shish mumkin. Buning uchun Project » Add
Repositary buyrug’ini bajarish va hosil bo’lgan muloqot darchasini to’ldirish
kerak.



1.2. DELPHI MUHITIDA MA’LUMOTLAR BAZALARI BILAN ISH
YURITISH TEHNOLOGIYALARI

Delphi muhitida ma’lumotlar bazalari bilan ishlash texnologiyalaridan biri -
Microsoft ActiveX Data Objects texnologiyasi ma’lumotlar bazalari bilan ish olib
borishni oson va tezkor amalgam oshiradi. ADO texnologiyasi va OLE DB
interfeyslari  Delphida yaratilgan dasturlarga hohlagan turdagi ma’lumotlar
bazalari bilan bog’lanish imkoniyatini beradi. Masalan, ADO dan foydalanuvchi
dastur SQL korporativ serveridagi ma’lumotlarga ham, electron jadvallarga ham,
local MBBT larga ham murakkab so’rovlarni bajara oladi. ADO orqali jo’natilgan
xoxlagan SQL so’rovi o’rinlanadi.

Bu ganday qilib amalgam oshirilib turadi? Buning hammasini ADO
mexanizmi va OLE DB interfeyslari amalgam oshirib turadi. OLE DB - bu
ma’lumotlar ustida bajariluvchi standart amallar va ma’lumotlar olmashishni
amalgam oshiruvchi maxsus funktsiyalar majmuasi bo’lib topiladi. ADO
terminologiyasi bo’yicha, xoxlagan ma’lumotlar manbayi (ma’lumotlar bazasi,
electron jadval, fayl) ma’lumotlar ombori deb tushuniladi, ushbu ma’lumotlar
ombori bilan dastur ma’lumotlar provayderi yordamida ish olib boradi. Dasturning
minimal komponentlar majmuasi 0’z ichiga bog’lanish obyektini, ma’lumotlar

majmuasi obyektini va so’rovlar protsessori obyektini oladi.

BDE va BDE Administrator

So’nggi paytda Borland kompaniyasi ma’lumotlar bazalari bilan osh olib
borishda SQL texnologiyalarini oldiga chigarib atirganligiga garamasdan, BDE
(Borland Database Engine — Borland ma’lumotlar bazalari mehanizmi) ancha
murakkab bo’lmagan ma’lumotlar bazalarini yaratishda haliyam keng ravishda
go’llanilmoqda. Bunga sabab fagat ushbu texnologiyaning osonligi emas-ki, ammo
xozirgi kundayam BDE ni foydalanuvchi dasturlar ishlab kelmogda va ushbu

dasturlarni sozlab turish lozim.



BDE qo’llaydigan ma’lumotlar bazalari parametrlarini sozl;ash uchun va
ushbu ma’lumotlar bazasiga psevdonim (Alias) yaratish uchun Delphi muhitiga
kiruvchi maxsus utilita — BDE Administrator qo’llaniladi. Bu utilitaning ishchi

maydoni 2 sahifadan iborat — Databases va Configuration (1-rasm).
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1-rasm. BDE Administrator Databases sahifasi oynasi

Databases sahifasida ma’lumotlar bazasiga oid alias larning tizimi
joylashgan. Delphi muhiti va BDE o’rnatilgach birnechta aliaslar yaratiladi,
masalan, DBDEMOS, DefaultDD va IBLocal. Yangi alias yaratish uchun Object
menyusidan New bo’limini tanlash lozim. Natiyjada biz MBBT tipini tanlay
oladigan oyna xosil bo’ladi. Ko’pchilik vosiyatlarda Standard tipi tushuniladi, bu
ma’lumotlar bazasini yaratishda Paradox drayveridan qo’llanishni anglatadi.
Undan keyin tizimda Standardl deb nomlanuvchi yangi element xosil bo’ladi, 0’ng
tomonda esa, xossalarni aniglash maydonida (Definition) barcha tahrirlash mumkin
bo’lgan parametrlar paydo bo’ladi. Delphi uchun standart tipi uchun bu xossalar
quyidagicha bo’ladi: tip (Type), MBBT drayveri (Default driver), hagiygiy

sonlarni turlandirish rejimi (Enable BCD) va ma’lumotlar bazasi joylashgan



katalog (Path). Yangi aliasni duzgach uning ismini ham o’zgartirshga imkoniyat
mavjud — buning uchun Object menyusidan Rename buyrug’l tanlanadi.

Aytaylik, bizning aliasimiz DATAL, ma’lumotlar bazasi esa C diskida Data
katalogida joylashgan bo’lsin. Dasturimiz C:\Data katalogidagi Paradox
ma’lumotlar bazasiga so’rov jonatish uchun fagat ushbu aliasni ko’rsatsak bo’ladi.

BDE Administratorning ikkinchi sahifasi - Configuration — Drivers
guruhidagi MBBT drayverlarin va System guruhidagi sistemalik 0’zggaruvchilarni
sozlash imkoniyatini beradi. Drayverlar BDE 0°zi boshgaruvchi (Native) va ODBC
orgali boshqgariluvchi bo’lib ikkiga bo’linadi (Open Database Connectivity — ochiq
ma’lumotlar bazalari biriktirilishi).

Sozlamalar ichida Langdriver optsiyasini ko’rib chigamiz, bu optsiya ham
sistemalik sozlamalarda (INT guruhi, 2-rasmga qora), ham har bir MBBT uchun
alohida mavjud bo’ladi. Kirill harflari bilan to’g’gri ish olib boorish uchun "Pdox
ANSI Cyrillic" ma’nosini o’rnatish kerak, u Windows-1251 kodirovkasiga mos
keladi, bu ma’no ham umumiy sozlamalarda (INIT), ham qgo’llaniluvchi MBBT

drayveri (masalan, Paradox) uchun ham o’rnatildai.
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2-rasm. BDE Administratorda sistemalik sozlamalar



Database Desktopda jadvallar yaratish

Ma’lumotlar bazalari bilan ish olib boruvchi dastur yaratganda jadvallar
bilan ish olib boorish uchun Delphi muhiti ichiga kiruvchi Database Desktop
dasturidan foydalansa bo’ladi. Database Desktop yordamida jadvallar hosil gilish,
o’larga yangi ma’lumotlar kiritish, ularni o’zgartirish va so’rovlar bilan ish olib
borishga bo’ladi.

Yangi jadval yaratish uchun File > New > Table buyrug’ini ishga tushirish
kerak. Bu yerda hosil gilinuvchi sahifa turini ko’rsatish mavjud bo’ladi, ko’pchilik
vasiyatda Paradox 7 formati tanlanadi, biz ham ushbu formatdan foydalanamiz.
Keyin esa jadval strukturasini aniqlash oynasi paydo bo’ladi (3-rasm), bu yerda
jadval parametrlari yaratiladi va ular sozlanadi, masalan, jadval maydonlari,

indekslari, parollar, shartlar va hokazo.
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3-rasm. Jadval strukturasini aniglash



11-BOB. DELPHI MUHITIDA PEDAGOGIK DASTURIY VOSITALARNI
YARATISH

2.1. MAKTAB KURSI MATEMATIKASIGA BOG’LIQ MASALALARNI
YECHISHGA MULJALLANGAN DASTURIY VOSITALAR YARATISH

Ushbu bo’limda biz maktab matematika kursiga oyid o’rgatuvchi dasturiy
vositalarni Delphi muhitida yaratilishni bosgichma-bosqich ko’rib chigamiz.
Magistrlik  dissertatsiya  ishimizning qo’shimchalar  sahifalarida  barcha

yaratiladigan dasturlar listinglari berilgan.

Uchburchak maydonini aniglash dasturi

Dastur o’quvchilardan uchburchakning uchta tomonini kiritishini so’raydi.
Ushbu kiritilgan uchta tomon qiymatlariga ko’ra dastur uchburchak maydonini
chigarib beradi.

Dasturning tashqi ko’rinishi 1-rasmda ko’rsatilgan. Formaga 3 ta Edit, 8 ta
Label, 1 Bitbtn va 1 Shape joylashtirilgan (1-rasm).

f}’ UCHBURCHAK MAYDOMNINI ANIQLASH | =R i:hl\
UCHBURCHAK MAYDONINI ANIGQLASH
A _
B |Edit2 4 XISOBLASH -
¢ [Eas MAYDON =

1-rasm. Dasturning tashqi ko’rinishi

Dastur algoritmi juda oddiy. Lekin ushbu dastur 5-7 sinf o’quvchilari uchun

foydali bo’ladi degan fikrdamiz.



Foydalanuvchi uchta Edit larga qiymatlar kiritgach, “Xisoblash” tugmasi
bosiladi va natiyjada oq to’rtburchak ichida 4 ta natiyja — foydalanuvchi tomonidan
kiritilgan 3 ta giymat va maydon chigadi.

Maydon bizga maktab kursidan belgili Geron formulasiga muvofiq
xisoblanadi. Barcha xisoblashlar, albatta, Bitbtn ning onClick voqgeasida olib

boriladi. 2-rasmda dasturning ishlash natiyjasini ko’ra olasiz (2-rasm).

[ 3 UCHBURCHAK MAYDONINI ANIQLASH [ESREERES]
UCHBURCHAK MAYDONINI ANIQLASH

Al _ A=3
B=4

B 4 A XISOBLASH ==

C |5 Maydon = 6

2-rasm. Dastur ishi natiyjasi

Bitbtnl ustiga ikki marta bosib, uning onClick vogeasiga quyidagi kodni
yozamiz:

procedure TForm1.BitBtn1Click(Sender: TObject);

var

a,b,c,s,p:real;

begin

a.=strtofloat(editl.Text);

b:=strtofloat(edit2. Text);

c.=strtofloat(edit3.Text);

p:=(at+b+c)/2;

s:=sqrt(p*(p-a)*(p-b)*(p-c));

label5.Caption:='A = "+editl.Text;

label6.Caption:='B = '+edit2.Text;

label7.Caption:='C = '+edit3.Text;

label8.Caption:='"Maydon = '+floattostr(s);



end:;

Kvadrat tenglamani yechish dasturi

Dastur o’quvchilardan ax2+bx+c=0 ko’rinishidagi kvadrat tenglamaning
uchta koeffitsiyentini kiritishini so’raydi. Ushbu kiritilgan uchta qiymatlarga ko’ra
dastur kvadrat tenglamaning (agar mavjud bo’lsa) ildizlarini chigarib beradi.

Dasturning tashqi ko’rinishi 3-rasmda ko’rsatilgan. Formaga 3 ta Edit, 8 ta

Label, 1 Bitbtn va 1 Shape joylashtirilgan (3-rasm).

/}’ KVADRAT TEMGLAMANI YECHISH |—|—|—J':' Of X |
KVADRAT TENGLAMANI YECHISH

A -
s DISKRIMINANT=
B |Editz 4 XISOBLASH X1 =
: X2 =
C |Edit3

3-rasm. Dasturning tashqi ko’rinishi

Dastur algoritmi juda oddiy. Lekin ushbu dastur 5-7 sinf o’quvchilari uchun
foydali bo’ladi degan fikrdamiz.

Foydalanuvchi uchta Edit larga qiymatlar kiritgach, “Xisoblash” tugmasi
bosiladi va natiyjada oq to’rtburchak ichida 3 ta natiyja — diskriminant va (agar
mavjud bo’lsa) tenglamaning X1 va X2 ildizlari qiymatlari chigadi.

Tenglamani yechish algoritmi bizga maktab kursidan belgili. Barcha
xisoblashlar, albatta, Bitbtn ning onClick vogeasida olib boriladi. 4-rasmda

dasturning ishlash natiyjasini ko’ra olasiz (4-rasm).



T KVADRAT TENGLAMANI YECHISH = | B i

KVADRAT TENGLAMANI YECHISH

A |1 }
| | | DISKRIMINANT = 1.00
B |3  AXISOBLASH | | X1=-1.00
| | x2=-200
C |2

4-rasm. Dastur ishi natiyjasi

Agarda tenglama yechimga ega bo’lmasa unda quyidaicha oyna paydo bo’ladi (5-
rasm):

z Project2 I& \

Diskriminant noldan kichik.
Yechim mavjud emas

5-rasm. Tenglama yechimga ega emas.
Bitbtnl ustiga ikki marta bosib, uning onClick vogeasiga quyidagi kodni

yozamiz:

procedure TForm1.BitBtn1Click(Sender: TObject);
var
a,b,c,d,x1,x2:extended;
begin
a:=strtofloat(editl. Text);
b:=strtofloat(edit2. Text);
c.=strtofloat(edit3. Text);
d:=sqr(b)-4*a*c;
if d>=0 then
begin
x1:=(-b+sqrt(d))/(2*a);




x2:=(-b-sqrt(d))/(2*a);
label5.Caption:='DISKRIMINANT = '+FLOATTOSTRf(D,ffFixed,4,2);
label6.Caption:="X1 = "+FLOATTOSTRf(X1,fffixed,4,2);
label7.Caption:="X2 = '+FLOATTOSTRf(X2,fffixed,4,2);

end

else

showmessage('Diskriminant noldan kichik.'+#13+"Yechim mavjud emas');

end:

2.2. O°’QUVCHILAR BILIM DARAJASINI ANIQLOVCHI DASTURIY
VOSITALAR YARATISH (MAKTAB KURSI MATEMATIKASIGA OID)

Ta’lim tizimiga axborot texnologiyalardan foydalanuvchi gismlarni kiritish
protsessida eng qiziqarli bo’limlardan biri — bu o’quvchilarning egallagan bilim
darajasini aniqlovchi dasturty vositalarni yaratish bo’lib topiladi. Ko’pchilik
xolatlarda bunday vosiyatlar deganimizda biz o’quvchilardan test topshiriglarini
avtomat ravshda o’tkazish imkoniyatini beruvchi dasturlarni tushunamiz.

Bunday dasturiy vositalarni maktab kursi matematikasiga oid yaratish
protsessini ko’rib chigaylik. Biz ushbu bo’limda maktab geometriyasi va algebrasi
kurslaridan besh-olti savoldan berib, o’quvchining bilim darajsini aniglaydigan
dasturiy ta’minotni yaratishni bosqichma-bosqich ko’rib chiqamiz.

Bunday dasturiy ta’minot yaratilgan paytda biz oldin birnechta savolga
javob berishimiz kerak. Ushbu savollar quyidagilardan iborat:

1. Savollar ganaga formatda bo’ladi? (faqat tekst, yoki grafika ham

aralashganma)

2. Savolni “o’tkazib yuborib”, so’ng ushbu savolga qaytib kelish imkoni

bormi yoki yo’qmi

3. Baxolash natiyjalari qanday formada bo’ladi? (html, excel fayl yoki

bloknotda)



Ushbu savollarga asoslana o’tirib, biz ikkita test olis dasturini ishlab
chigamiz. Birinchi test olish dasturi maktab matematikasiga oid bo’ladi, ikkinchi
dasturimiz esa maktab geometriyasiga oyid bo’ladi. Ikki dastur ham grafikadan
foydalanish imkoniyatini beradi, natiyjalar esa html formada saglanadi. Testdan
o’tish vaqt bo’yicha chegaraga ega emas, shu sababli har bir savol ketma-ket
yechilishi lozim.

Savollar oldinnan Word tekst muharririda ishlab chigilgan, har bitta savol —
bo’lak hujjat, barchasi web-hujjat formatida saglangan (Word muharririda Fayl-
Soxranit’ kak Web-stranitsu buyrug’i orqali).

Har bir dasturimiz 10 ta savoldan iborat.

‘MATEMATIKA'’ test olish dasturi

Ushbu dastur maktab matematikasining 5-sinfi bo’yicha 10 ta savoldan

iborat. Dastur tashqi ko’rinishi 1-rasmda ko’rsatilgan:

& 'MATEMATIKA' TEST DASTURI =NACN X

'MATEMATIKA' TEST DASTURI

Dt

Timerl

WebBrowserl: TWebBrowser
Origin: 16, 96; Size: 609 x 393

Tab Stop: True; Order: 0 Webbrowserl
';J'A\'/'OBLA'R"""""""""""""'""'ZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZ?
A ~ B ol o = D NATIYJA: :
...............................................................................

1-rasm. Dastur tashqi ko’rinishi



Dasturni xosil gilishni bosgichma-bosqich ko’rib chqamiz. Delphi muhitini

ishga tushuramiz va quyidagilarni bajaramiz:

1.
2.

Formaga Label componentasin o’rnatamiz.
Uning xossalarida “Align=Top”, “Caption="MATEMATIKA’TEST

DASTURI” va “Alignment=Center” ma’nolarini beramiz.

3. “Internet” bo’limidan WebBrowserl komponentini o’rnatamiz

9.

Label2 ni formaga joylashtirib, “Caption="ISMINGIZ’” xossasini
0’zgartiramiz

Edit] komponentasini Label2 yoniga qo’yamiz

“Additional” bo’limidan BitBtnl komponentini joylashtiramiz va
“Kind=Ignore”, “King=Custom”, “Caption="TESTNI BOSHLASH’”
ma’nolarini xossalarga o’rnatamiz

“Standard” bo’limidan 1 RadioGroup va 4 RadioButton o’rnatamiz,
RadioButtonl da “Checked=True”, “Caption="A’" xossalarini, boshga
RadioButtonlarga esa mos ravichda ‘B’, ‘C’ va ‘D’ ma’nolarni Caption
xossalariga qo’yib chigamiz

“Additional” bo’limidan Shapel ni formaga WebBrowserl pastiga
joylashtiramiz va uning ustiga “Standard” bo’limidan Label3 ni qo’yamiz

Label3 ning “Caption” xossasigga “Natiyja” degan ma’no beramiz

10. “System” bo’limidan Timerl ni o’rnatamiz

Ushbu orqgali biz 1-rasmdagi formaga ega bo’lamiz. Shu bilan forma dekorativ

ishlari tugaydi.

Endi savollarni tayyorlaymiz. Savollarni Word tekst muharririda web-sahifa

rejimida saqglash lozim. Barcha savollarni proektning ‘test’ katalogi ichiga

joylashtirish lozim.

Testning ishlash jarayonini 2-rasmda ko’rsak bo’ladi:



BT TETOST | —
'MATEMATIKA' TEST DASTURI

ISMINGIZ: |Asal /; TESTNI BOSHLASH |

SAVOL #1

-

1. Qaysi gatorda raqamlar to’g i ko rsatilgan?

JAVOBLAR
’7(* A B fallo: - D NATIYJA:

2-rasm. Test ishlash jarayoni
Test olish jarayoni to’lig’i bilan Timerl elementining onTimer voqeasida bo’ladi.
Demak, biz Timerl komponentining onTimer voqgeasi ichiga quyidagilarni

yozamiz:

procedure TForml.TimerlTimer(Sender: TObject);
begin
inc(i);
if i<=10 then
begin
webbrowserl.Navigate(extractfilepath(application.ExeName)+'t
est\'+inttostr(i)+'.htm");
label4.Caption:="SAVOL #'+inttostr(i);
timerl.Enabled:=false;

end



else finish;

end;

Shuning bilan birga har bitta javob tanlanganda savollar olmashib turushi

amalgam oshiriladi va berilgan javob to’g’ri yoki to’g’ri emasligi tekshirilib turadi:

procedure TForml.RadioButtonlClick(Sender:

begin
if key[i]=1 then inc(k);
timerl.Enabled:=true;

end;

procedure TForml.RadioButton2Click(Sender:

begin
if key[i]=2 then inc(k);
timerl.Enabled:=true;

end;

procedure TForml.RadioButton3Click(Sender:

begin
if key[i]=3 then inc(k);
timerl.Enabled:=true;

end;

procedure TForml.RadioButton4Click(Sender:

begin
if key[i]=4 then inc(k);
timerl.Enabled:=true;

end;

TObject);

TObject);

TObject);

TObject);



Bu yerda key — test kaliti massivi. K esa — to’g’ri javoblar xisoblagichi. Natiyjalar

finish protsedurasida beriilgan:

procedure TForml.finish;

begin

timerl.Enabled:=false;

if k<6 then label3.Caption:='NATIYJA: 2!';
if k=7 then label3.Caption:="NATIYJA: 3!"';
if k=8 then label3.Caption:='NATIYJA: 4!';
if k>8 then label3.Caption:="NATIYJA: 5!°';

end;

‘GEOMETRIYA’ test olish dasturi

Ushbu dastur maktab geometriyasining 7-sinfi bo’yicha 10 ta savoldan

iborat. Dastur tashqi ko’rinishi 3-rasmda ko’rsatilgan:

T 'MATEMATIKA' TEST DASTURI SRICE X

'GEOMETRIYA' TEST DASTURI

(ISMINGIZ: |Edit] A TESTNI BOSHLASH

: SAVOL # §

L
__ Timerl

WebBrowserl: TWebBrowser
Origin: 16, 96; Size: 609 x 393
Tab Stop: True; Order: 0 Webbrowserl

AVOBLAR T :
COA © B il o D NATIYJA: :
..........................................................................

3-rasm. Dastur tashqi ko’rinishi



Dasturni xosil gilishni bosgichma-bosqich ko’rib chqamiz. Delphi muhitini
ishga tushuramiz va quyidagilarni bajaramiz:

11.Formaga Label componentasin o’rnatamiz.

12.Uning xossalarida “Align=Top”, “Caption="GEOMETRIYA’TEST

DASTURI” va “Alignment=Center” ma’nolarini beramiz.

13.“Internet” bo’limidan WebBrowserl komponentini o’rnatamiz

14.Label2 ni formaga joylashtirib, *“Caption="ISMINGIZ’” xossasini

0’zgartiramiz

15.Edit] komponentasini Label2 yoniga qo’yamiz

16.“Additional” bo’limidan BitBtnl komponentini joylashtiramiz va

“Kind=Ignore”, “King=Custom”, “Caption="TESTNI BOSHLASH’”
ma’nolarini xossalarga o’rnatamiz

17.“Standard” bo’limidan 1 RadioGroup va 4 RadioButton o’rnatamiz,

RadioButtonl da “Checked=True”, “Caption="A’" xossalarini, boshqa
RadioButtonlarga esa mos ravichda ‘B’, ‘C’ va ‘D’ ma’nolarni Caption
xossalariga qo’yib chigamiz

18.“Additional” bo’limidan Shapel ni formaga WebBrowserl pastiga

joylashtiramiz va uning ustiga “Standard” bo’limidan Label3 ni qo’yamiz
19.Label3 ning “Caption” xossasigga “Natiyja” degan ma’no beramiz

20. “System” bo’limidan Timer] ni o’rnatamiz
Ushbu orqgali biz 1-rasmdagi formaga ega bo’lamiz. Shu bilan forma dekorativ
ishlari tugaydi.

Endi savollarni tayyorlaymiz. Savollarni Word tekst muharririda web-sahifa
rejimida saglash lozim. Barcha savollarni proektning ‘test’ katalogi ichiga
joylashtirish lozim.

Testning ishlash jarayonini 4-rasmda ko’rsak bo’ladi:



BT TETOST | —
'MATEMATIKA' TEST DASTURI

ISMINGIZ: |Asal /; TESTNI BOSHLASH |

SAVOL #1

-

1. Qaysi gatorda raqamlar to’g i ko rsatilgan?

JAVOBLAR
’7(* A B fallo: - D NATIYJA:

4-rasm. Test ishlash jarayoni
Test olish jarayoni to’lig’i bilan Timerl elementining onTimer voqeasida bo’ladi.
Demak, biz Timerl komponentining onTimer vogeasi ichiga quyidagilarni

yozamiz:

procedure TForml.TimerlTimer(Sender: TObject);
begin
inc(i);
if i<=10 then
begin
webbrowserl.Navigate(extractfilepath(application.ExeName)+'t
est\'+inttostr(i)+"'.htm");
label4.Caption:="SAVOL #'+inttostr(i);
timerl.Enabled:=false;

end



else finish;

end;

Shuning bilan birga har bitta javob tanlanganda savollar olmashib turushi

amalgam oshiriladi va berilgan javob to’g’ri yoki to’g’ri emasligi tekshirilib turadi:

procedure TForml.RadioButtonlClick(Sender:

begin
if key[i]=1 then inc(k);
timerl.Enabled:=true;

end;

procedure TForml.RadioButton2Click(Sender:

begin
if key[i]=2 then inc(k);
timerl.Enabled:=true;

end;

procedure TForml.RadioButton3Click(Sender:

begin
if key[i]=3 then inc(k);
timerl.Enabled:=true;

end;

procedure TForml.RadioButton4Click(Sender:

begin
if key[i]=4 then inc(k);
timerl.Enabled:=true;

end;

TObject);

TObject);

TObject);

TObject);



Bu yerda key — test kaliti massivi. K esa — to’g’ri javoblar xisoblagichi. Natiyjalar

finish protsedurasida beriilgan:

procedure TForml.finish;

begin

timerl.Enabled:=false;

if k<6 then label3.Caption:='NATIYJA: 2!';
if k=7 then label3.Caption:="NATIYJA: 3!"';
if k=8 then label3.Caption:='NATIYJA: 4!';
if k>8 then label3.Caption:="NATIYJA: 5!°';

end;

I11-bob. Pedagogik dasturiy vositalarni ma’lumotlar bazalarin boshqarish
tizimlari bilan integratsiyalash

3.1. Pedagogik dasturiy vositalarning ma’lumotlar bazasini yaratish

Biz ushbu ishimizda “Algortimlash asoslari” mavzusidagi electron resurslar
ma’lumotlar bazasini yaratishni maqsad qilib qo’yganmiz. Ushbu resurs nima
uchun kerakli bo’ladi?

Birinchi navbatda, ushbu dasturimiz, albatta, algoritmlashtirish asoslari kabi
fanni o’rganuchi talabalar yoki dasturlashga qiziquvchi hohlagan inson uchun
bizning dasturiy ishlanmamiz katta foyda keltiradi deb aytsak ham bo’ladi. Ushbu
dasturni yaratish uchun biz ADO texnologiyasidan foydalanganmiz. Keeling
ushbu texnologiya hagida gisgacha tushuncha berib ketayik.

ADO (ActiveX Data Objects) Delphi dasturlash muhitining 5-chi
versiyadisan boshlab paydo bo’ldi. Ushbu texnologiya Microsoft tomonidan

yaratilgan bo’lib, u ishlash printsiplari BDE ga uxshash bo’lib keladi.



ADO tehnologiyasidan Delphi dasturlash muhitida foydalanishga misol
sifatida quyidagicha masalani yechib ko’rsatamiz.
Mayli bizda gandaydir MS Access MBBT da yaratilgan quyidagicha jadval

berilgan bo’lsin:

Ne Ismi Sharifi
1 Yodgorbek Risqulov
2 Elyor Doniyorov

Ushbu jadvalni biz Delphi proektida DBGrid komponenti orgali
chiqarishimiz kerak bo’lsin.

Delphidi ishga tushurib, File-New-Application orqgali yangi proyekt hosil
gilamiz. Endi formaga quyidagi komponentlardi o’rnatamiz (1-rasm):

TDBGrid

TDataSource

TADOConnection

TADOQuery

j}%rm'_ = C‘ﬁ

il +«——— | DBGd

a8y g fw ki

ADO Connection

l

WE ADO
= iﬁ I-E' Query
A

DataSet

1-rasm



Ushbu komponentlari ko’rib chigamiz:

TDBGrid DataControls sarlavxasida joylashgan bo’lib, u ma’lumotlar
bazasidagi jadvalni ko’rsatish uchun qo’llaniladi

TDataSource Data Access sarlavxasida joylashgan bo’lib, u DBGrid bilan
ma’lumotlar bazasini bog’lash uchun qo’llaniladi

TADOConnection ADO sarlavxasida joylashgan bo’lib, u bizning
ma’lumotlar bazamizni qandaydir provayder bo’yicha bog’lanishini ishga oshirib
turadi

TADOQuery ham ADO sarlavxasida joylashgan bo’lib, u ma’lumotlar
bazasidan kerakli ma’lumotni olishga yordam berib turadi.

Mayli bizning yuqoridagi jadvalimiz nomi Student bo’lsin. Ushbu jadval
to’g’ri bizning proektimizda ko’rinishi uchun kerakli amallarni bajarish lozim:

1. TAdoQuery komponentining Connection hossasi orgali  ushbu

maydonda TAdoConnection ni tanlash orqali bog’lanishni o’rnatamiz

2. TDataSource komponentining DataSet hossasida esa TadoQuery ni
ko’rsatamiz
3. TDBGrid ning DataSet xossasida TdataSet ni tanlaymiz

Endi esa biz AdoConnection komponentini sozlashimiz kerak. Buning uchun
quyidagilarni amalga oshiramiz:

1. LoginPromt xossasiga False ma’nosini beramiz (ma’lumotlar bazasiga
qo’shilgan paytimizda parol so’raydigan oyna xosil bo’lmasligi
uchun)

2. ConnectionString xossasi yonindagi ... tugmasiga bo’sib, 2-rasmdagi

oynani xosil gilamiz:

Formi.ADOConnection1 ConnectionString

Source of Connection

™ Use Data Link File

[ JZ |

* Use Connection String

| Build...
ak. | Cancel | Help |

2-rasm



3. Ushbu oynada “Build” tugmasini bosamiz va 3-rasmdagi oynani xosil

gilamiz:

BY CRojicTeA CRA3H C JAHHBIMM [Z|

[9CTABILMHE AaHHEL l nD,U,KﬂH:I'-IEHHE] ﬂDnDnHmeanD] Bce ]

B bIﬁEFIHTE NogENDY3EMBIE 03HHEBIE!

MNocTaswwry OLE DB

tediaCatalogDB OLE DB Provider
tediaCataloghdergedDB OLE DB Provider
MediaCatalogtw/ebDB OLE DB Provider

Microzoft Jet 4.0 OLE DE Prowvider

ticrozoft OLE DB Provider For D ata Mining Services
icrozaft OLE DB Provider for Indesing Service
Microzaft OLE DB Provider for Intermet Publizhing
Microzaft OLE DB Provider for ODBC Dinivers
Microsaft OLE DB Provider for OLAP Services 3.0
icrozoft OLE DB Provider for Oracle

Microzaft OLE DB Prowvider for Outloak Search
Microzoft OLE DB Provider for SOL Server
Microzoft OLE DE Simple Provider

k5D ataShape

SOL Mative Client

Maocraswue, OLE DB anA eyt kaTanoros

kK ‘ OTrieHa | Cnpaeka J

3-rasm



4, Ushbu oynadan Microsoft Jet 4.0 OLE DB Provaider ni tanlaymiz va

Daleye tugmasiga bosamiz (4-rasm)

MocTaEWwE AaHHeR  [100KACHEHHE l .ﬂDI‘IDﬂHH‘I’EJ‘IbHD] Brce ]

HEa#uTe CEEAEHMA 408 NOLKAKYEHHA K 0aHHBIM ACCess:

1. Briepure 1M BEEAMTE MtA Ba3kl LaHHBI:

2. Besaure ceeoEHMA AR BROLa B Ba3Y 0aHHEIR:

Nonezoearent: |.-f".|:|min

¥ Mucroinapone | Paspewsts coxpadeHie napona

MpoEBEpHTE NOAE MHOYEHE |

] 8 | OTraeHa | Cnpaeka |
4-rasm
5. Ushbu oynada bizning ma’lumotlar bazamizga yo’Ini ko’rsatamiz va

foydalanuvchi nomiga Admin deb yozamiz. Agarda bizning
ma’lumotlar bazamiz proekt papkasida joylashgan bo’lsa, bunday
sharoyitda fagat ma’lumotlar bazasining kengaytmasi va nomi
ko’rsatilsa yetarli bo’ladi/ masalan BD\mydb.mdb.

6. Endi esa «Ox» tugmasiga bosib, TADOConnection ning Mode

xossasiga cmShareDenyNone ma’nosini ko’rsatamiz.

Bog’lanishni amalgam oshirdik. Endi ma’lumotlar javalimizda ko’rinishi uchun

formamizning onCreate voqgeasiga quyidagi kodni yozsak etarli bo’ladi:



procedure TForml.FormCreate(Sender: TObject);
begin

ADOQueryl1.SQL.Clear;
ADOQuery1.SQL.Add('SELECT * FROM Student’);
ADOQueryl.Active:=True;

end:

Dasturning ishlash natiyjasi quyida ko’rsangiz bo’ladi (5-rasm):

fﬁ’ Forml

fe |zmi Sharifi
| 4 “f odgorbek Risquloy
2 Elyor Dioniyorow

m

5-rasm

Dasturning to’liq kodini “Qo’shimchalar” bo’limida keltirib o’tganmiz.




3.2. O’QUVCHILAR BILIM DARAJASINI RIVOJLANISHTIRADIGAN
MA’LUMOTLAR BAZASINI YARATISH

Bizning ushbu dasturimiz quyidagi interfeysga ega bo’ladi (1-rasm):

i ALGORITMLER HAQQINDAGT MAQALALAR BAZAST =R X

Fayl Elew 7

Algoritmlestiriw ha'm programmalastiriw
ALGORITMLER HAQQINDAG'l| MAQALALAR BAZASI'

1-rasm

Dastur quyidagi menyu satrlaridan iborat (2-rasm):
]
% ALGORITMLER HAQOQINDA

Fayl | Izlew 7

Magala qosiw

Shig'iw

2-rasm
Fayl bo’limida maqola qo’shishga (6-rasm) va dasturdan chigishga imkon beruvchi
buyruglar joylashgan. “Izlew” bo’limi esa ma’lumotni izlash oynasini hosil qiladi

(3-rasm):



(" —— — e ———— —
Statyalardan mag'li'wmat izlew — ﬂ

lzleniwshi so'z: |

Izlew turi

+ Statya atamasinda " Gilt so'zlerden

3-rasm
“?” bo’limida maqola qo’shish hagida yordamchi ma’lumot chiqarish (4-rasm) va
dastur avtorlari hagida ma’lumot chigarish (5-rasm) imkonini beruvchi buyruglar

joylashgan



Eayl Dlew ?
Algoritmlestiriw ha'm programmalastiriw
‘ ALGORITMLER HAQQINDAG'I| MAQALALAR BAZASI' |
-
[ BSsrans Magqala qosiw tartibi I
Daslep File --> Maqala qosiw
1. Magala atin korsetiw
2. Magqalaga tiyisli bapti tanlaw (joq bolsa payda etiw)
3. Magalaga tiyisli bap bolimin tanlaw (joq bolsa payda etiw)
4. Gilt sozlerdi kiritiw
5. Magala tekstin kiritiw (Word hujjetinen kopiyalap aliw ha'm ornatiw)
o e -
1 Maqola at: ,
A Seqlaw.
Tons 2 =] B Tarmtares
Utes taras: 3 | & Taza utes torau
Ggit so'rler: & %
Mogola tekst §
_ _ __ /
4-rasm

-
Statyalar bazasi - Magistratura u

Algaritrler hagainda statpalar bazasi

Werzion 1.0

Copyright 2016 by MMPI - Magiztratura

Al rightz resemed




Taz_a _staﬁyfjog w —

Magala ati:
I ﬁ Saqlaw
Tarau: I | f&: Taza tarau |
Ules tarau: I j < Taza ules tarau |
X Biykarlaw
Ggilt so'zler: I

Magala teksti:

6-rasm
Ushbu dasturli tayorlashda biz ADO texnologiyasidan foydalanganmiz.

Ma’lumotlar bazasi esa Microsoft Access 2003 dasturida yaratilgan (7-rasm).

=
@ nmpi : Baza gaHHe (gopmat Access 20007
L Ozkpems 2 Koncrpyxrop = Cozgate | X | 28 T i
OBwekThl Cozganwe TaBnuupl B pesnMe KOHCTPYKTOPE
A Tabnuue 2l  Cosganwe TaBanuel © nomowso MacTepa
& 3anpoce 2H  Cosganwe TaBanuel nyTem BBO43 AaHHBIX
. o
PopmMebl
2 Ortuertsl
"la CTpaHuLel
= Makpoce
g2 Mogynw
Ipynnel
[l WsBpanHoe

7-rasm



7-rasmdan ko’rinib turibdi, ma’lumotlar bazamiz nomi — nmpi. Ushbu ma’lumotlar

bazamizda fagat bitta pages nomli jadvalimiz mavjud. Jadval strukturasi 8-rasmda

berilgan:
| ';_l IIIIII_lI » OO QONNDIA |~|.|.|L||_|I'\!1ﬂl LTS S
_1 pages: Tabnnua
Wma nona | Tin AaHHbIX
% |id CUETUMK
__ | keyword TeKCTOBRIA
__|title TeKCTOBGIA
__|parent TeKCTOBLIA
__|child TeKCTOBLIA
¥
8-rasm.

Keling ushbu dastur bilan ish olib borishni ko’rib chigayik.

Eng birinchi marta dastur ishga tushirilganinda chap tomondagi menyu bo’sh

ko’rinishga ega bo’ladi (9-rasm):

@ ALGORITMLER HAQQINDAGT MAQALALAR BAZAST

e — =ARCE X

Fayl Dlew 7
Algoritmlestiriw ha'm programmalastiriw
ALGORITMLER HAQQINDAG'| MAQALALAR BAZASI

@ Menyu bo'sh

9-rasm
Dasturga yangi maqola qo’shish kerak. Buning uchun Fayl-Maqola qo’shish
buyrug’ini amalgam oshirib, 6-rasmdagi oynani xosil gilamiz. Ushbu oynaga
diggat bersak, bizdan quyidagi maydonlar to’ldirilishi so’ralgan:
1) Magola nomi
2) Magqola tegishli bo’lgan guruh (chap tomonda chigadi)
3) Magqola tegishli bo’lgan kichik guruh (agar tegishli bo’lsa)



4) Kalit so’zlar (maqolada uchrashadigan kalit so’zlar)
5) Magola matni (Word dasturida tayorlangan maqolani ko’chirib, ichiga
solamiz)

Ushbu amallarni bajarib bo’lgach, “Saqlash” tugmasini boshish lozim
bo’ladi. Natiyjada maqola bazaga qo’shilib, o’ngga tegishli chap tomonda menyu
paydo bo’ladi. Agar biz maqolani saqlashni hohlamasak, “Bekorlash” tugmasini
boshish orgali maqgola Kkiritish oynasini yopib tashlaymiz, maqola bazada
saglanmaydi.

10-12 rasmlarda biz dasturga “Graflar” nomli guruhiga kiruvchi va shu
guruhning ichidagi “Eng qisqa yo’l” nomli kichik guruh a’zosi bo’lgan “Deykstra

algoritmi” nomli maqolani qo’shganimiz gadamba-gadam ko’rinib turibdi.

¥ ALGORITMLER HAQQINDAGT MAQALALAR BAZAST'
Ilew 7

e Algoritmlestiriw ha'm programmalastiriw
Shig'iw ./ \' ALGORITMLER HAQQINDAG'I| MAQALALAR BAZASI

[

10-rasm



- v . . - -
pazacane Joi B e ————— m-._u
Maqala ati: IDeykstra algoritmi
b Saglaw
Tarau: IGraﬂar | f&: Taza tarau |
Ules tarau: IE"Q kichik yo'l j «» Taza ules tarau |
X Biykarlaw

Gailt so'zler: IDeykstr& algoritm
Magala teksti:

Deykstra algoritmi hagida

Deykstra algoritmi gandaydir A va B nuhtalari orasida mumkin bo'lgan yo'llar orasidan eng kichik yo'lni topish algoritmi bo'lib topiladi

11-rasm
4 ALGORITMLER HAQQINDAGT MAQALALAR BAZAST - ——— (il e
- - N =
Fayl [lew 7
Algoritmlestiriw ha'm programmalastiriw
ALGORITMLER HAQQINDAG'l| MAQALALAR BAZASI
El- Graflar
E- Eng kichik yo'l Deykstra algoritmi hagida
Deykstra algoritmi gandaydir A va B nuhtalari orasida mumkin bo'lgan yo'llar orasidan eng kichik yo'lni topish

algoritmi bo'lib topiladi

12-rasm




Endi ushbu dizimda izlashni o’rganamiz. 1zlash tizimi ikki hilda: kalit
so’zlar yoki maqola nomi orqgali ishlaydi. Biz izlash turini 0’zimiz mos maydonni
belgilash orqali o’rnatamiz.

13-rasmda biz kalit so’zlar orqali yuqorida kiritilgan maqolani topdik:
( Statyalardan mag'li'wmat izlew @\

Izleniwshi so'z: |dey|

Izlew turi

" Statya atamasinda @« Gilt so'zlerden

Deylkstra algoritmi

13-rasm
Rasmdan ko’rinib turibdi, biz kalit so’zlar bo’yicha izlash rejimini o’rnatganmiz va
izlanuvchi satrga faqay ‘dey’ deb yozib qo’yganmiz. Izlash interaktiv rejimda
amalgam oshirilib turibdi. Demak, tizimimiz yaxshi ishlab turibdi.

Ushbu tizim kodlari 1-qo’shimchada berilgan.



Xulosa

Biz ushbu magistrlik dissertatsiyamizda Delphi dasturlash tizimi orgali
o’rgatuvchi adabiyotlar va boshqa da materiallarni ma’lumotlar bazalarini
boshqarish tizimlari bilan bog’langan xolda ishlatish masalasini ko’rib chiqdik.
Dastlab ishimizda Delphi muhiti orqali ma’lumotlar berib ketganmiz. So’ngra
ushbu muhitda gandaydir amaliy masalalarni yechish ham qarashtirilib o’tilgan.

Delphi muhitining MBBT lar bilan ishlash mehanizmlari ham ko’rib
chigilgan. BDE, Database Desktop yordamchi tizimi va, albatta, ADO
texnologiyasi hagida aytilgan. ADO tizimi bilan masalalar yechishga mizollar
keltirilgan.

Ishimizning uchinchi bo’limida biz yuqorida keltirib o’tilgan a’lumotlardan
foydalangan xolda Delphi muhiti va ADO texnologiyasiga asoslangan
“Algoritmlashtirish asoslari” nomli amaliy magqolalar ma’lumotlar bazasidan
turuvchi tizim ishlab chigganmiz va ushbu tizim bilan ishlash jarayonini gadamba-
qadam ko’rsatib o’tganmiz.

Albatta, biz ushbu tizimni to’liq darajada yetishgan tizim deb ayta
olmaymiz, sababi bu yerda biz tizim funktsionalini sal kamroq jiddiylashtirishimiz
lozim bo’ladi, masalan, tizimga maqola qo’shish uchun maxsus parol yoki maxsus
menyu yaratish kerak, birnechta tillar (rus, inglis) bilan ishlashishni amalga
oshirish kerak va hokazo. Biz bu ishimiz natiyjasida paydo bo’lgan tizim misolida
Delphi muhitining MBBT lar bilan ish olib borish mexanizmlarini ko’rib chigishni
asosily magsad qilib qo’ganmiz. Dasturimizni esa xoxlagan payt xoxlagan odam
rivojlantirishi mumkin. Dastur kodini to’lig’i bilan I-qo’shimchada keltirib

o’tganmiz.



QO’SHIMCHALAR



I-Qo’shimcha

“Algoritmlashtirish asoslari” maqolalar bazasi kodi

unit Unitl; /Bosh forma

interface

uses
Windows, Messages, SysUtils, Variants, Classes, Graphics, Controls, Forms,
Dialogs, OleCtrls, SHDocVw, ComCitrls, StdCtrls, Menus, ExtCtrls, DB,
ADODB,comobyj;

type

TForml = class(TForm)
Labell: TLabel,
Label2: TLabel;
TreeViewl: TTreeView;
StatusBarl: TStatusBar;
MainMenul: TMainMenu;
Fayll: TMenultem;
Janalawl: TMenultem;
N1: TMenultem;
Shigiwl: TMenultem;
Izlewl: TMenultem;
N2: TMenultem;
Statyaqosiwtartibil: TMenultem;
Dasturavtorlaril: TMenultem;
Panell: TPanel;
WebBrowserl: TWebBrowser;

DataSourcel: TDataSource;



ADOConnectionl: TADOConnection;
ADOQueryl: TADOQuery;
procedure DasturavtorlarilClick(Sender: TObject);
procedure ShigiwlClick(Sender: TObject);
procedure Izlew1Click(Sender: TObject);
procedure Janalaw1Click(Sender: TObject);
procedure FormCreate(Sender: TObject);
procedure FormClose(Sender: TObject; var Action: TCloseAction);
procedure TreeViewlClick(Sender: TObject);
procedure StatyaqosiwtartibilClick(Sender: TObject);
private
{ Private declarations }
public
{ Public declarations }
node:TTreeNode;

end;

var
Forml: TFormi,

implementation

uses Unit2, Unit3, Unit4,

{$R *.dfm}

procedure TForml.DasturavtorlarilClick(Sender: TObject);
begin

aboutbox.show

end;



procedure TForm1.ShigiwlClick(Sender: TObject);
begin

showmessage('Xosh, saw boliniz!");

form1.Close

end:

procedure TForml.l1zlew1Click(Sender: TObject);
begin
form3.show

end:;

procedure TForml.Janalaw1Click(Sender: TObject);
var

I;integer;

begin

form4.utarau:=false;

form4.tarau:=false;

for i:=0 to treeviewl.Items.Count-1 do

if treeviewl.ltems.Item[i].Level=0 then
form4.ComboBox1.ltems.Add(treeviewl.ltems.ltem[i]. Text);
form4.show

end:

procedure TForml1.FormCreate(Sender: TObject);

begin
form1.Caption:=label2.Caption;
treeviewl.LoadFromFile(extractfilepath(application.ExeName)+'config.sys');

end:



procedure TForml.FormClose(Sender: TObject; var Action: TCloseAction);

begin

if messagebox(0,'Saglanamizba?','Shigiw',1)=1 then
treeviewl.SaveToFile(extractfilepath(application.ExeName)+'config.sys');

end:

procedure TForml1.TreeViewlClick(Sender: TObject);

var

ss:string;

n:TTreeNode;

K:integer;

w:olevariant;

begin

n:=treeviewl.Selected;

if (n.Level<>0) and (n.Parent.Level<>0) then
begin
ss:=n.Text;
adoqueryl1.SQL.Clear;
adoqueryl.SQL.Add('SELECT * FROM [pages] WHERE [title]=:p1");
adoqueryl.Parameters.ParamByName('p1l').Value:=ss;
adoqueryl.Active:=true;
k:=adoqueryl.Fieldoyname('id‘).Value;
w:= CreateOleObject("Word.Application’);

w.Visible := False;

w.Documents.Open(extractfilepath(application.ExeName)+'files\'+inttostr(k)+".rtf")



w.ActiveDocument.SaveAs(extractfilepath(application.ExeName)+'files\ntmiI\'+int
tostr(k)+'.html', 8);
w.Quit(False);

w:=Unassigned;

webbrowserl.Navigate(extractfilepath(application.ExeName)+'files\htmI\'+inttostr
(k)+".html");
end;

end:

procedure TForm1.StatyaqosiwtartibilClick(Sender: TObject);

var

f.textfile;

begin

assignfile(f,extractfilepath(application.ExeName)+'temp.htm’);

rewrite(f);

writeln(f,'<h3>Magala qosiw tartibi</h3><hr>");

writeln(f,'<p align=justify>');

writeln(f,'&nbsp;Daslep File --> Magala qgosiw<br>");
writeln(f,'&nbsp;1.&nbsp;Magala atin korsetiw<br>");
writeln(f,'&nbsp;2.&nbsp;Magalaga tiyisli bapti tanlaw (jog bolsa payda
etiw)<br>";

writeln(f,'&nbsp;3.&nbsp;Magalaga tiyisli bap bolimin tanlaw (jog bolsa payda
etiw)<br>";

writeln(f,'&nbsp;4.&nbsp;Gilt sozlerdi kiritiw<br>');
writeln(f,'&nbsp;5.&nbsp;Magala tekstin kiritiw (Word hujjetinen kopiyalap aliw
ha'+#39+'m ornatiw)<br>"),

writeln(f,'<br><center><img src=files/intro.gif width=550px></center></p>");

closefile(f);



webbrowserl.Navigate(extractfilepath(application.ExeName)+'temp.htm’);

end:;

end.

unit Unit2; /Dastur avtorlarini chigaruvchi forma

interface

uses Windows, SysUtils, Classes, Graphics, Forms, Controls, StdCitrls,
Buttons, ExtCitrls;

type

TAboutBox = class(TForm)
Panell: TPanel;
Programlcon: TImage;
ProductName: TLabel;
Version: TLabel;
Copyright: TLabel,
Comments: TLabel,
OKButton: TButton;
procedure OKButtonClick(Sender: TObject);

private
{ Private declarations }

public
{ Public declarations }

end;

var
AboutBox: TAboutBox;



implementation

{$R *.dfm}

procedure TAboutBox.OKButtonClick(Sender: TObject);
begin

aboutbox.Close

end,

end.

unit Unit3; /l1zlash formasi

interface

uses
Windows, Messages, SysUtils, Variants, Classes, Graphics, Controls, Forms,
Dialogs, StdCtrls, Buttons,comobj, ExtCtrls;

type
TForm3 = class(TForm)

Labell: TLabel,
Editl: TEdit;
RadioGroupl: TRadioGroup;
rb1l: TRadioButton;
ListBox1: TListBox;
rb2: TRadioButton;
procedure FormShow(Sender: TObject);
procedure ListBox1Click(Sender: TObject);
procedure EditlChange(Sender: TObject);



private

{ Private declarations }
public

{ Public declarations }

end:

var
Form3: TForm3;

implementation

uses Unitl;

{$R *.dfm}

procedure TForm3.FormShow(Sender: TObject);
begin

editl.Clear;

editl.SetFocus;

listbox1.Clear

end;

procedure TForm3.ListBox1Click(Sender: TObject);
var

K:integer;

w:olevariant;

begin

If listbox1.ltems.Count>0 then

begin

with form1 do



begin
adoquery1.SQL.Clear;
adoqueryl.SQL.Add('SELECT * FROM [pages] WHERE [title]=:p1");

adoqueryl.Parameters.ParamByName('p1').Value:=listbox1.ltems.Strings[listbox1.
Itemindex];

adoqueryl.Active:=true;

k:=adoqueryl.Fieldbyname('id’).Value;

w:= CreateOleObject("Word.Application’);

w.Visible := False;

w.Documents.Open(extractfilepath(application.ExeName)+'files\'+inttostr(k)+".rtf")

w.ActiveDocument.SaveAs(extractfilepath(application.ExeName)+'files\html\'+int
tostr(k)+'.html’, 8);
w.Quit(False);

w:=Unassigned;

webbrowserl.Navigate(extractfilepath(application.ExeName)+'files\htmlI\'+inttostr
(k)+".html");
end,;
form3.Close;
end;

end:

procedure TForm3.Edit1Change(Sender: TObject);
var

li:integer;



begin
listbox1.Clear;
if length(editl.Text)>1 then
begin
if rb1.Checked then
begin
with form1 do
begin
adoquery1.SQL.Clear;
adoqueryl.SQL.Add('SELECT * FROM [pages] WHERE [title] LIKE
'+#39+'%'+editl. Text+'%'+#39);
/ladoqueryl.Parameters.ParamByName('pl’).Value:=editl.Text;
adoqueryl.Active:=true;
adoqueryl.First;
for i1:=0 to adoqueryl.RecordCount-1 do
begin
listbox1.ltems.Add(adoqueryl.fieldbyname('title’). AsString);
adoqueryl.Next;
end;
end;
end
else
begin
with form1 do
begin
adoqueryl.SQL.Clear;
adoqueryl.SQL.Add('SELECT * FROM [pages] WHERE [keyword] LIKE
'+#39+'%'+editl. Text+'%'+#39);
/ladoqueryl.Parameters.ParamByName('pl’).Value:=editl.Text;



adoqueryl.Active:=true;
adoqueryl.First;
for i1:=0 to adoqueryl.RecordCount-1 do
begin
listbox1.Items.Add(adoqueryl.fieldbyname('title'). AsString);
adoqueryl.Next;
end,
end;
end,
end,
end;

end.
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